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Objectives 
 
You will use a provided model for Mill-Lesson-16, and then generate the toolpaths to machine 
the part on a CNC vertical milling machine. This Lesson covers the following topics: 
 
� Establish Stock Setup settings: 
Stock size using Bounding Box. 
Material for the part. 
Feed calculation. 
 
� Prepare model for cutting by: 
Creating surfaces from solid faces. 
Using Silhouette Boundary for containment boundaries. 
Creating flat boundary surfaces. 
 
� Generate 3-dimensional milling toolpaths consisting of: 
Importing toolpaths 
Rest Roughing 
Finishing Horizontal Area 
 
� Inspect the toolpath using Mastercam’s Verify by: 
Launching the Verify function to machine the part on the screen. 
Comparing a verified part to the original stock stl file. 
Generating the NC- code. 
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TOOL LIST 
� 1.000 diameter flat end mill to rough and finish machine. 
� .250 diameter flat end mill to rough and finish machine. 
� .0625 diameter flat end mill to finish machine 
� .500 diameter ballnose to finish machine 
� .125 diameter ballnose to finish machine 
� .0313 diameter ballnose to finish machine 
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MILL-LESSON-16 - THE PROCESS 
 

Toolpath Creation 
TASK 1:  Setting the environment 
TASK 2: Open existing file from the multimedia CD 
TASK 3:  Define the rough stock using stock setup 
TASK 4:  Prepare geometry for roughing and rest roughing 
TASK 5:  Importing the Core Roughing toolpath 
TASK 6: Rest Roughing using Surface High Speed (Rest Roughing) 
TASK 7:  Apply Mastercam High Feed functionality 
TASK 8:  Finish flat surfaces using Surface High Speed (Horizontal) 
TASK 9:  Importing Waterline and Surface Finish Leftover toolpaths 
TASK 10:  Verify the toolpath and compare to STL file 
TASK 11:  Save the updated MCX file 
TASK 12: Post and create the CNC code file 
TASK 13: Create ActiveReport 
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TASK 1: 
SETTING THE ENVIRONMENT 
Before starting the geometry creation you should set up the grid, toolbars and machine type as 
outlined in the Setting the environment section at the beginning of this text: 
1. Set up the Grid.  This will help identify the location of the origin. 
2. Customize the toolbars to machine a 3D part. 
3. Set the machine type to a Haas Vertical Spindle CNC machine. 
 
Please Note:  
Review the videos on the CD before working through each task.    
 
There is some intricate geometry selection techniques used in this lesson and reviewing the 
procedures on the CD will make it easier for you to complete this lesson. 
 
 

Toolpath Creation 
TASK 2: 
OPEN EXISTING FILE FROM THE MULTIMEDIA CD 
 
� On the multimedia CD that came with this text is a folder called Mastercam-Files. The file 

is in inch units and contains the wireframe and surface (solid) geometry of the part. 
� The part is already setup for a: GENERIC HAAS 4 – AXIS VMC. 
 
1. Select File>Open> Mill-Lesson-16.MCX.  
2. If confronted with the System Configuration dialog box activate the radio button for All 

settings. 

 
 
 
� System Configuration (switch units) dialog box 
� When you open a part file that uses different units (English or metric) from those currently in 

use, Mastercam automatically displays this dialog box, which informs you that Mastercam is 
switching units and loading an alternate default configuration file. In order to complete the 
operation, select one of the following options: 

� Units: Tells Mastercam to use only the units from the new configuration file. (default) 
� All settings: Tells Mastercam to load all settings from the new configuration file. 
 

3. Select the OK button  to exit the System Configuration dialog box. 
4. Activate a shaded view by selecting the icon at the top of the screen. 
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TASK 3: 
DEFINE THE ROUGH STOCK USING STOCK SETUP 
 
1. Click on the Toolpaths Tab as shown below: Note; Alt-O will Show/hide the Operations 

Manager pane. 

 
 
2. Select the + in front of Properties to expand the Toolpaths Group Properties.  Select Stock 

setup in the toolpath manager window.  Select the Bounding box button: 

 
 
3. Set the parameters to match the Bounding Box screenshot in the left image below, then 

select the OK button . 

  
 
4. Set the parameters to match the Stock Setup screenshot shown in the above right image.  

Since the expand option in the bounding box window increased the size of the stock in both 
the negative and positive directions, the Z dimension needs to be reduced by 0.1.  Simply 
select the Z dimension and add – 0.1 and hit enter. 

 

Sam
ple

 O
nly

 

no
t to

 be
 us

ed
 

for
 tra

ini
ng



 Mill-Lesson-16 
 
 

Mill-Lesson-16 Page - 6 

5. Select the Tool Settings tab and change the parameters to match the Tool Settings 
screenshot below.  Note: The Feed Calculation is set to From material.  To change the 
Material type follow the instructions below: 

 

 
To change the Material type to Aluminium 
6061 pick the Select button at the bottom of 
the Tool Settings page. 
 
At the Material List dialog box open the 
Source drop down list and select Mill – 
library. 
 
From the Default Materials list select 
ALUMINIUM inch -6061 and then select the 

OK button  .   
 
 
 

 
6. Select the Edit button to enter the material definition.  At this time we will not make any 

changes to Mastercam’s defaults, but it is important to know how this function works. 
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Material Definition allows the user to enter the Base cutting speed (Surface Feet per Minute) 
and Base feed per tooth/revolution (Chip Load).  These base values can be arrived at based 
on the material used.  Mastercam’s default values are very conservative so we will use them for 
safety purposes during this tutorial. 
 
% of Base by Operation Type allows the user to specify a variation in SFM based on the 
operation type.  Eg, face milling will have a much higher SFM than profile milling. 
 
% of Base by Tool Type allows the user to vary feed per tooth by the tool.  Eg. endmills will 
typically have a much higher feed per tooth (FPT) than a ballnose tool will. 
 
Allowable tool materials and additional speed/feed percentages allows the user to further 
customize based on the tool type. 
 
The user can further adjust SFM and chip load percentages in each tool definition.  This is 
demonstrated during the first operation in TASK 4. 
 
If cutting on a machine, it is extremely important that you research recommended SFM and FPT 
for your tools and material and make the appropriate settings in Mastercam. 
 

7. Select the OK button  again to complete this function. 

8. Select the OK button  again to exit the Machine Group Properties. 

9. Now select the Fit to screen icon  then select the Isometric View icon.  
� Your part should look similar to the screen shot below:  With X0 Y0 at the center and Z zero 

on the top of the stock. 
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TASK 4: 
PREPARE GEOMETRY FOR ROUGHING 
� In this task you will use create surfaces and containment boundaries for machining. 
� The first step will be to cover areas of the core that will later be machined by electrode. 
 
Please Note:  
Review the videos on the CD before working through each task.    
 
There is some intricate geometry selection techniques used in this lesson and reviewing the 
procedures on the CD will make it easier for you to complete this lesson. 
 
1. From the bottom Status menu bar select Level. 
2. In the Number field type 10, and in the Name field type My Roughing.  Level 10 will 

become highlighted to indicate that it is the main level. 

 

The Level Manager is a good way to 
organize your geometry for easy 
reference. 
 
The highlighted level is the main level.  
Any geometry created always goes onto 
the current main level.  To select a level as 
main simply click on the number of the 
level in the level list. 
 
The X under the column called Visible 
indicates whether or not the geometry on a 
certain level is showing.  The main level is 
always visible. 
 
It is possible to leave the Level Manager 
open at all times. 
 

 
 
3. Click on the X under the visible column to hide the other levels except 2.  Be sure to keep 

the new level as the main.  Click the 10 to do so. 

4. Select the OK button  to exit. 
5. Select a bright colour by left clicking on the System Colour in the bottom Status menu bar.  

6. Select colour 137, , then select the OK button  to exit. 
7. From the top menu bar select Create>Surface>Flat Boundary... 
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8. The chaining dialogue will appear.  Select C-Plane. 

 
 
9. Unshade the model using Alt+S. 
10. Select the wireframe in any order as shown below: 

 
 

11. Click on OK   to exit Chaining. 

12. Select the OK button  to create the surfaces and exit. 
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13. Using Alt+S to shade the model will show the flat surfaces created: 

 
 
14. Now that you know how to turn levels on and off, check your work by comparing with the 

surfaces on level 3. 
 
� Next we will create surfaces to be used for machining and creating containment boundaries. 
 
15. From the bottom Status menu bar select Level. 
16. In the Number field type 11, and in the Name field type My Rest Roughing. 
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17. Click on the X under the visible column to hide all of the levels except 1.  Be sure to keep 
the new level as the main.  Click the 11 to do so. 

18. Select the OK button  to exit. 
 
Please Note:  
Review the videos on the CD before working through each task.    
 
There is some intricate geometry selection techniques used in this lesson and reviewing the 
procedures on the CD will make it easier for you to complete this lesson. 
 
 
19. Select Create>Surface>From Solid...  
20. Be sure that only the Solid Face selection method is active. 

 
 
21. To begin carefully select all of the surfaces in the front pocket.  There are some very small 

ones so carefully zooming in to each area will help.  If you make an incorrect selection, 
selecting the same surface again will unselect it. 
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22. Check your work by comparing with the front surface on level 4.  There are 44 surfaces in 
total.  If you have missed a surface, repeat steps 19 through 21 adding only the surfaces 
that you have missed.  Do not worry about the floor surface with the holes in it.  We will 
fix this later. 

23. Repeat steps 19 through 21 to create surfaces from the solid faces on the other pockets. 
24. Again, check your work by comparing with level 4 and the picture below.  Do not worry 

about the floor surface with the holes in it. 

 
 
In order to avoid machining areas that will be burned by electrode, we will fill in the floors of our 
rest roughing surfaces just as we did for the roughing.  Clean, continuous, untrimmed geometry 
will always give better toolpath processing results. 
 
25. Delete the floor surface at the front of your part as shown below.  Click on it then hit the 

Delete button on your keyboard. 

 
 
26. Open the Level Manager and make level 10 visible while keeping level 11 as the main. 
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27. Pre-select the three surfaces that will fill the holes in your rest roughing surfaces.  They are 
shown below:  Please Note: In the screen shot below some of the surfaces have been 
hidden the sake of clarity.  

 
 
28. Right click on Level in the bottom Status menu bar then make the selections shown below 

to copy the surfaces to level 11 for rest roughing. 

 
 

29. Press OK   to exit. 
30. Your screen should now look like this: 
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� Next we will create containment boundaries. 
 
31. Enter the Level Manager and ensure that level 11 is the main level and all others are not 

visible. 

32. Select the OK button  to exit. 
33. Select 2D and set the Z level for geometry creation as 0. 

 
 
34. Select Create>Silhouette Boundary...  
35. You are prompted to Select solids, solid faces, or surfaces. 
36. Select all of the surfaces on the screen.  To window select the geometry click in the top left 

corner of the graphics window and drag the mouse to the bottom right before clicking again. 

37. Click on the End Selection button.  

38. Select the OK button  to select the default Silhouette Boundary options.  Your 
screen should look the same as below: 
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TASK 5: 
IMPORTING THE CORE ROUGHING TOOLPATH 
� In this task you will import the core roughing toolpath used in Lesson 15 and alter it to rough 

the part. 
 
1. Enter the Level Manager and ensure that level 1 is the main level and all others are not 

visible 
2. Right click in the Operations Manager and select Import from the list as shown below: 

 
 
3. The Import Toolpath Operations window will now appear.  Using the Select Operations 

file button browse and select the source folder that has the Mill-Lesson-15.mcx file stored 
within it and select the first operation, Surface High Speed (Core Roughing). 

 
 

4. Select the OK button  to import the operation. 
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5. You will be asked whether you want to Import/add the operation groups also.  Select No: 

 
 
6. A message will appear indicating 1 operation has successfully been imported.  Hit the 

Cancel button  to return to the operations manager. 
7. Your operation manager should now have one dirty operation as shown below: 

 
 
8. Select Geometry from the first operation. 
9. First select the Drive Surfaces select button.  When prompted to Select Drive surfaces, 

window select all of the entities on the screen. 

10. Click the End Selection icon .  
11. Click on the Containment Button.  

 
 
12. The wireframe level is not currently active to select the containment boundary.  Select Level 

from the bottom Status menu bar.  Then make level 2 visible. 

13. Exit with the OK button . 
14. Select C-plane in the Chaining window as shown in the left image below.  Then select the 

chain around the top of the mold base as shown in the right image below: 

 

 

 

15. Click on OK   to exit Chaining. 
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16. Confirm the number of drive surfaces as shown below: 

 
 

17. Click the OK button  to exit the Toolpath/surface selection. 
18. Click on the Parameters folder and move into the Cut Parameters page and enter the 

parameters as shown: 

 
 

19. Click the OK button  to complete the operation. 

20. Select the Regenerate all dirty operations icon . 
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� Now you will inspect the toolpath using Mastercam’s Backplot function. 
21. In the operations manager, click on the + sign to the left of the toolpath to expand it.  Then, 

left click on the bottom line with the toolpath information. 

 
 

22. Press the Next Stop button  to move to the end of the toolpath. 
 
In the backplot you have the ability to jump to a particular location in a toolpath just by clicking 
on it. This helps during inspection of large toolpaths. 
 

 
23. Exit the backplot by clicking the OK button . 
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TASK 6: 
REST ROUGHING USING SURFACE HIGH SPEED (REST ROUGHING) 
TOOLPATHS 
� In this task you will use a .250 diameter end mill to continue roughing the part. 
 
1. Open the Level Manager and make level 11 the main level while making all other levels 

invisible. 
2. On the status bar at the bottom of the screen select 2D/3D to toggle to 3D construction. 
3. In the Operations Manager, copy the operation by selecting it with your mouse then 

pressing Ctrl+C. To past the operation, select the red arrow with your mouse then press 
Ctrl+V. 

 
 
4. Expand the information for the newly created operation by pressing the + button, and then 

select the Parameters button. 
5. Change the Toolpath Type to Rest Roughing. 

 
 
6. Select the Remove selected drive surfaces button (1) then select the Select drive surfaces 

button (2). 

 
 
7. You are prompted to Select Drive Surfaces. 

8. Press the  button to move to the Top View. 
9. Left click on the screen and Window select the pocket at the front of the part as shown 

below: 

 

By default Mastercam will only 
select surfaces that are 
completely inside the window. 
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10. Click the End Selection icon .  You will see 44 drive surfaces selected. 
11. Similarly, clear the existing containment boundary (1), then click to select a new one (2). 

 
 
12. You will be prompted to Chain 2D tool containment boundary # 1. 
13. Change to the Isometric View then select the chain as shown below: 

 
 

14. Click on OK   to exit Chaining. 
15. Move to the Tool page, press the Select library tool..., and select a 1/4 Flat Endmill and 

click the OK button  to return to the Tool page.  Notice that the FPT and SFM set 
themselves based on the Material Library selection: 
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16. Make the appropriate changes as shown in the Cut Parameters tab below: 

 
 
17. Make the appropriate changes as shown in the Rest Material tab below: 

 

Compute 
remaining stock 
from: 
 
Use the dimensions 
of the roughing tool 
to create the stock 
to be machined by 
the toolpath. 
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18. Make the appropriate changes to the Transitions tab as shown below: 

 
 
19. On the Steep/Shallow page, type Z into the Minimum depth field and press enter. 

 
 
20. You will be prompted to Select a point. Open the Level Manager and make level 2 

(wireframe) visible.  Then, select a point along the chain that runs along the top of the 
surface: 
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21. Repeat the process for the Maximum depth field and select a point on the front pocket as 
shown below: 

 
 
22. The following values should be entered for the Minimum and Maximum depth: 

 
 
23. Select the Linking Parameters tab and set the parameters as shown below: 
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24. Select the Arc Filter/Tolerance tab and adjust the parameters as shown below: 

 
 

25. Press the OK button  to complete the toolpath. 
26. Regenerate the operation by selecting the Regenerate all dirty operations icon in the 

Operations Manager. 
27. Turn on levels 1 and 11 then backplot the operation.  Position your Graphics View so you 

can see the tool lead-in to the initial cut. 
28. Click the mouse anywhere inside the graphics area then press the S button on your 

keyboard to step through the toolpath. 
 

� The tool is gouging the part on the right hand side.  The gouge is on an adjacent part of the 
solid outside of the containment boundary.  The tool must be allowed outside of the 
boundary to cut the entire surface, so check surfaces must be added to avoid gouging. 

 
 
29. Select Parameters under the second operation in the Operation Manager.  Return to the 

Toolpath Type page of the operation and click the Select Check Surfaces button. 
30. You will be prompted to Select Check Surfaces.   
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31. Change the selection method to Active solid selection. 

 
 
32. Make sure the Select face is the only method that is active. 

 
 
33. Select all of the solid faces that are adjacent to the drive surfaces as shown below: 

 

34. Click on the end selection button . 

35. Hit the OK button  to exit the toolpath. 
36. Regenerate the toolpath and Backplot the toolpath to confirm the gouge has been 

removed. Accept any warning messages. 
 
It is generally advisable to use Check Surfaces whenever you have surfaces that are adjacent 
to the Drive Surfaces.  If your toolpath Drive Surfaces include all of the surfaces or solid faces 
in or around the cutting area then check surfaces are not necessary. 
 
� Next you will rough out the pockets on the sides of the part. 
37. In the Operations Manager, copy and paste Operation 2 to create Operation 3. 
38. On the Toolpath Type page of the new operation, remove the drive geometry.  Add the 

solid on level 1 as shown below left, and the surfaces on level 10 as shown below right (all 
except the one on the top of the part) as the new drive geometry.  You must select all of the 

geometry before pressing the End Selection icon .  You should have 445 entities. 
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39. Add the 4 Chains shown below as Containment Boundaries: 

 
 
40. On the Steep/Shallow page, repeat steps 19 through 22 to select the top and bottom of the 

group of solid faces shown in the following Isometric View: 

                  
 

41. Complete the toolpath by selecting the OK button . 
42. Regenerate the operation.  Accept any warning messages and Backplot to view the results. 

 

You have just completed two examples of rest 
roughing.  Each method has its own advantages 
as explained below. 
 
The first one used only the surfaces/faces of the 
pocket as the Drive Surfaces.  As a result, you 
needed to select Check Surfaces to protect the 
adjacent geometry.  Toolpath processing is 
typically faster when you select a minimal 
number of Drive and Check Surfaces. 
The second example involved selecting the entire 
solid for machining.  Toolpath processing will 
typically take longer in this case.  Check 
Surfaces typically do not have to be selected in 
this case.  The advantages of this method will be 
further illustrated as we copy and paste this 
toolpath to rough out the other pockets. 
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TASK 7: 
APPLY MASTERCAM HIGH FEED FUNCTIONALITY 
 
� Next you will apply the High Feed function to the roughing toolpaths. 
 
The High Feed function is used to adjust the feed rate of the tool on the fly to keep a constant 
volumetric material removal rate.  This typically results in a decrease in cycle time and can 
greatly increase machining productivity. 
 
The function will also ease the tool in and out of the material between cuts to avoid shocking the 
tool and inserts.  This typically results in an increase in cycle time but can greatly increase tool 
life. 
 
In your operations, you set a base feed rate for the particular tool and operation.  High Feed will 
allow you to supply a minimum and maximum feed rate for the tool as well as a feed rate for air 
cuts.  The calculation will vary the tool’s feed rate on each based on the location of the cutter 
with respect to the material and the volume of material being removed during the move. 
 
1. In the Operations Manager.  Right click on Toolpath Group-1.  Select Groups>Rename 

and enter Roughing as the new name. 

 
 
2. Right Click on Machine Group-1.  Select Groups>New Toolpath group and enter 

Finishing as the new toolpath group name. 

 
 
3. Select all of the roughing operations by selecting Roughing then select the High Feed 

button: 
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4. Make the following selections in the Highfeed machining dialogue box: 

 

The Minimum feed rate is the low end of the 
adjustment range and will be used when a high 
volumetric rate of material removal occurs or when 
the tool is entering the stock. 
 
The Maximum feed rate is used when the tool is 
cutting very little material. 
 
Maximum air cutting feed rate is for positioning 
between cuts.  It is possible to increase this to the 
highest allowable feed rate by your CNC 
controller. 
 
Up and Down feed rate scale factors adjust the 
cutting when the tool is lifting or plunging. 
 
The Stock Setup tab allows you to setup stock in 
the same way that you would with Verify. The 
default stock comes from the Stock Setup that 
you completed in TASK 2. 
 

 
5. Exit the dialogue box then select the Run button in the ribbon bar. 

 
 
� The Highfeed machining results will be displayed after calculating.  We have reduced the 

cycle time by 12.7%.  Select Yes to keep the results. 

 
 
6. Notice that in the Operations Manager, Mastercam has locked operations for editing now.  

Each operation has a lock  next to the operation. 
7. To illustrate the results, backplot any of the toolpaths, select the Expand or contract this 

dialogue button and watch the feed rate vary as you step through the toolpath. 
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TASK 8: 
FINISH FLAT SURFACES USING SURFACE HIGH SPEED 
(HORIZONTAL) 
 
� Next you will finish the flat portions of the part using the Surface High Speed (Horizontal) 

toolpath. 
 
The Horizontal toolpath strategy will automatically find flat, or horizontal, surfaces to machine.  
For programming, it is efficient to use Mastercam’s various functions such as Horizontal, 
Waterline and Rest Material to isolate part features and machine them with the best strategy 
and tools. 
 
Using the bottom of a flat endmill or fly cutter will give a better surface finish on floor surfaces 
than a ballnose endmill will because there will be no scallops.  Alternatively, a ballnose tool will 
provide a much better surfaces finish for shape profiling.  
 
1. In the Operations Manager confirm that the red arrow used to locate new operations is in 

the Finishing Toolpath Group.  If it is not, simply grab it with the left mouse button, and 
drag it to the desired location. 

2. Create a new operation, by right clicking in the Operations Manager window, select Mill 
toolpaths>Surface high speed toolpath.... 

3. Add Drive Surfaces, and select all of the entities on the Solid (1) and Roughing (10) 
levels. 

4. Turn on level 2 and add the top edge of the mold base as the Containment Boundary.  

 
 

5. Select the OK button  to exit. 
6. Change the Toolpath Type to Finishing Horizontal Area. 
7. Navigate to the Tool page and select the 1.000 Flat Endmill that was previously used for 

roughing. 
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8. Make the appropriate selections on the Cut Parameters page shown below.  Note that the 
Stock to leave for all finishing toolpaths will be 0. 

 
 
9. Turn Off the Trochoidal motion as shown below: 
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10. Set the Transitions parameters as shown below: 

 
 
11. On the Steep/Shallow page select the Detect limits button to fill in the Minimum and 

Maximum depth: 
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12. Set the Linking Parameters as shown below: 

 
 
13. Set the Arc Filter/Tolerance values as shown below: 

 
 
14. Navigate to the Coolant tab and turn the Flood coolant on. 

15. Select the OK button  to complete the toolpath. 
16. In the Operations Manager, copy Operation 4, which was just created, and paste the 

operation directly after, to create Operation 5. 
17. Select the Parameters option under Operation 5. 
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18. On the Toolpath Type tab, select the  button in the Drive window.  You will be 
prompted to Select Drive Surfaces.  All of the Drive Surfaces from the previous toolpath 
are currently highlighted.  Unselect the solid base of the part as shown below and then click 

the  End Selection icon. 

 
 
19. On the Tool page, Change the tool to the 1/4 Flat Endmill used previously. 
20.  Select the Cut Parameters page and make the necessary changes to match the screen 

shown below: 
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21. Select the Trochoidal motion page and enter the parameters shown below: 

 

Minimize burial 
will apply trachoidal 
motion to the 
toolpath anywhere 
that the tool is 
moving into an area 
where it’s leading 
edge profile would 
fully loaded.  The 
trachoidal (circular) 
motion that is 
applied allows the 
tool to use a 
stepover that is 
close to the one 
programmed on the 
Cut Parameters 
page.  You can 
control the circular 
motion’s radius 
and vary Stepover 
as well. 
 

22. Select the Transitions page and set the parameters as shown below: 

 
 

Sam
ple

 O
nly

 

no
t to

 be
 us

ed
 

for
 tra

ini
ng



Mastercam Training Guide 
 
 

Mill-Lesson-16 Page - 35 

23. On the Steep/Shallow page enter the following values for Z depth: 

 
 

24. Select the OK button  to complete the toolpath. 
25. Regenerate the operation by selecting the Regenerate all dirty operations icon in the 

Operations Manager. 
26. Copy Operation 5 and paste the operation below to create Operation 6. 
27. Click on the Parameters for Operation 6. 
28. On the Toolpath Type page, clear the Drive surfaces by selecting (1) Remove selected 

drive surfaces, then click on (2) Select drive surfaces. 

 
 
29. Make sure the Select face is the only method that is active. 

 
 
30. Select the 4 surfaces from the solid shown below and click on the End Selection button: 

 
 
31. Select the Select check surfaces button and add the surfaces shown below: 

 
 
32. Click on the Remove selected containment boundary button. 
33. On the Tool page, select a 1/16 Flat Endmill. 
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34. Setup the parameters on the Cut Parameters page as shown below: 

 
 
35. Turn Off the Trochodial motion. 
36. On the Transitions page, setup the parameters as shown: 
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37. On the Steep/Shallow page, select the Detect limits button and ensure the values match 
the image below: 

 
 
38. On the Linking Parameters page, setup the parameters as shown below: 

 
 

39. Select the OK button  to complete the toolpath. 
40. Click on the Regenerate all dirty operations icon in the Operations Manager.  Accept any 

warning messages. 
41. Review Operations 4, 5 and 6 using Backplot: 
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TASK 9: 
IMPORTING WATERLINE AND SURFACE FINISH LEFTOVER 
TOOLPATHS 
 
� Next you will import the waterline and surface finish leftover toolpaths from Lesson 15. 
 
1. Ensure the red arrow is at the bottom of your operations list in the finishing toolpath group.  

Select the red arrow and drag it to the bottom if it is not there already. 
2. Right click in the Operations Manager and select Import. 
3. The Import Toolpath Operations window will now appear.  Select the source folder that 

has the Mill-Lesson-15.mcx file stored within it and select the final three operations, 
Surface High Speed (Waterline) and the two Surface Finish Leftover operations: 

 
 

4. Select the OK button  to import the operation. 
5. You will be asked whether you want to Import/add the operation groups also.  Select No: 

 
 
6. You will be prompted letting you know that 3 operations have successfully been imported.  

Hit the Cancel button  to return to the operations manager which should now look like 
the image below: 

 
 

Sam
ple

 O
nly

 

no
t to

 be
 us

ed
 

for
 tra

ini
ng



Mastercam Training Guide 
 
 

Mill-Lesson-16 Page - 39 

7. Select Geometry in Operation 7. 
8. Click on Select Drive Surfaces and window select all the solids on level 1, then click on 

End Selection. 
9. Click on Select Check Surfaces and select the solid body shown below: 

 
 

10. Click the OK button  to complete the toolpath. 
11. Repeat steps 7 through 10 for Operations 8 and 9. 
12. Click on the Regenerate all dirty operations icon in the Operations Manager.  Accept any 

warning messages. 
13. Review Operations 7, 8 and 9 using Backplot: 
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TASK 10:   
VERIFY THE TOOLPATH AND COMPARE TO STL FILE 
 
Using Mastercam’s Compare to STL file function will allow us to identify areas on the part that 
require further machining as well as areas that may have been gouged.  It is important to keep 
in mind that tolerances play a very large role in the use of this function.  Accuracy of a 
comparison can only be as accurate as your machining tolerance. 
 
1. Use the Alt+Z shortcut to get to the Level Manager, turn on level 1, make all other levels 

invisible, exit the manager. 
2. In the top menu bar, select File>Save Some.  You will be prompted to Select the entities 

to save.  Select the two solids (the main part and the base).  End the selection. 
3. The Save As dialogue box will open.  Browse to your Mastercam directory, then the data 

sub directory. 
4. Select the Options button and make the selections below. 

 
 
5. For Save as type select .STL file then save the file with the name MILL-LESSON-16.STL. 

 
 

6. Select all of the operations you have completed so far by picking the Select All icon . 
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7. Select the Verify selected operations button circled below: 

 
 
8. Select the Turbo button. Turbo does not display the tool or holder and does not perform live 

updates of the stock, which is updated at the end of the verification.  Turbo is generally the 
fastest option for verification. 

  
9. Check mark Stop on collision and set values as shown below: 
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10. Select the Options button  then make the following selections: 

 
 

11. Accept the selections by pressing the OK button  then select the machine button to 
verify the toolpath. The verified part is shown below: 

 
 

 
 

12. The STL Compare dialogue box is now open.  Select the File button  and select the 
.stl file that you saved in step 3. 
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13.  The comparison stock model is now loaded.  Select the Compare the machined stock 
and the STL file.  The computed results are shown below: 

 
 
Compare the colours on the model with those on the chart at the left.   
 
The light to dark blue shaded areas indicate additional stock to remove.   
 
The finishing tolerance was .001 so anything between light blue and yellow will be acceptable 
and considered complete. 
 
Purple to red shaded areas would indicate part gouges and areas in previous toolpaths that 
need to be addressed! 
 

14. Exit the STL Compare and Verify functions by clicking on the OK button . 
 
TASK 11:  
SAVE THE UPDATED MCX FILE 

1. Select the save icon from the toolbar . 
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TASK 12:  
POST AND CREATE THE CNC CODE FILE 

1. Ensure all the operations are selected by picking the Select All icon  from the Toolpath 
manager. 

 
 
2. Select the Post selected operations button from the Toolpath manager. 
Please Note: If you cannot see G1 click on the right pane of the Toolpath manger window and 
expand the window to the right. 

 
 
3. In the Post processing window, make the necessary changes as shown below: 

 
 

4. Select the OK button  to continue. 
5. Enter the same name as your Mastercam part file name in the NC File name field Mill-

Lesson-16. 
6. Select the Save button. 
7. The CNC code file opens up in the default editor. 

8. Select the  in the top right corner to exit the CNC editor 
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TASK 13:  
CREATE ACTIVEREPORT 
 
� Finally, you will create a report to help with part setup at the machine. 
 
1. In the top menu bar, select Settings>Configuration>Toolpaths then change the Setup 

Sheet program to ActiveReport.   

 
 

2. Select the OK button  to exit. 
3. Setup the screen so level 1 is the main and no other levels are visible.  Exit the Level 

Manager and shade the solid. 
4. Right click inside the Operations Manager window and select Setup Sheet.... 

5. Select the OK button  to generate the report. 
6. The ActiveReports Viewer will load automatically.  You have the option of saving the report 

as any of the following file formats. 

 
 
This completes Mill-Lesson-16. 
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MILL–LESSON-16 EXERCISE 
 
� The Mill-Lesson-16-Exercise file can be found on the accompanying DVD in the 

Mastercam-Files folder and is called Mill-Lesson-16-Exercise.mcx. 
 
Use the information learned in Lesson 16 to create a toolpath for the Mill-Lesson-16-Exercise. 
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